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Android. This paper gives you the information about Paramount (Online) Real Estate. The user can easily find real 
estate property’s and information about real estate property’s by this application At Paramount, we offer premium 
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Introduction 
               A software requirements specification (SRS) 
is a comprehensive description of the intended 
purpose and environment for software under 
development. The SRS fully describes what the 
software will do and how it will be expected to 
perform. An SRS minimizes the time and effort 
required by developers to achieve desired goals and 
also minimizes the development cost. A good SRS 
defines how an application will interact with system 
hardware, other programs and human users in a wide 
variety of real-world situations. 
 The application in android will get the basic 
information about all details of particular Paramount 
real estate (Paramount Real Estate is a group of 
companies) and about any information about real 
estate and buy land will get instantly through this 
application and it will show the best way or location 
of the Paramount Real Estate registered office in 
India. And also will get online registration instantly 
we can use it any were at any time by using web view 
also you can access real estate website through this 
application it shows the online registration form 
directly in webpage user can response as soon as 
possible instantly and this application providing best 
real estate consultation help so user can save time.
 When any user want to buy and sell any real 
estate property so user may face some problems for 
searching good property, in case may be user don’t 
have much time, may be find lack of real estate 
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Abstract 

The paper entitled “PARAMOUNT REAL ESTATE THROUGH ANDROID" has been developed using 
Android. This paper gives you the information about Paramount (Online) Real Estate. The user can easily find real 
estate property’s and information about real estate property’s by this application At Paramount, we offer premium 
Real Estate services throughout the India like Selling & buying Flats, Buildings, Lands selling & buying, 
Developments as well as residential and commercial leasing. For over 39 years our clients have enjoyed exceptional 

om our experienced team. We invite you to inspect our properties which are 
updated daily. If you would like to know more information on any of the properties listed on this application, if you 
would like more information about how we can assist you with your real estate needs, then check this application. 
The application will be designed using Android Development Tool (ADT) and Software Development Tool (SDK) 

: ANDOROID, REAL ESTATE, PARAMOUNT, JAVA, SDK. 

A software requirements specification (SRS) 
is a comprehensive description of the intended 
purpose and environment for software under 
development. The SRS fully describes what the 
software will do and how it will be expected to 

An SRS minimizes the time and effort 
required by developers to achieve desired goals and 
also minimizes the development cost. A good SRS 
defines how an application will interact with system 
hardware, other programs and human users in a wide 

The application in android will get the basic 
information about all details of particular Paramount 
real estate (Paramount Real Estate is a group of 
companies) and about any information about real 

y through this 
application and it will show the best way or location 
of the Paramount Real Estate registered office in 
India. And also will get online registration instantly 
we can use it any were at any time by using web view 

te website through this 
application it shows the online registration form 
directly in webpage user can response as soon as 
possible instantly and this application providing best 
real estate consultation help so user can save time. 

uy and sell any real 
estate property so user may face some problems for 
searching good property, in case may be user don’t 
have much time, may be find lack of real estate  

 
consultant, etc. in case user will interact with internet 
or any other real estate consultant, if the person want 
more about any information about the real estate. 
Person will interact this application and find most of 
information about Paramount Real Estate  and if the 
user really want to  buy or sell property so  user can 
register account directly using this application and 
directly contact by E-Mails,SMS,Call etc . If the user 
is enable to go to Paramount real estate office so user 
can use Google map and easily see all registered 
office in India. Users can appointment for real estate 
consulting. Even if user really buys or sells. so now 
user can easily contact to register office and can save 
time and money. 

 
Use Case Model Survey  
            A use-case is a description of a set of 
sequence of actions, including variants that 
performs to yield an observable result of value to an 
actor. 
Roles  

• Smart Phone 
• Applications 

 
Smartphone 

[1] Mobile phone module should be compatible 
with the application build.

[2] Application should be installed on device.
[3] Device should be Smartphone.
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[4] GPRS and EDGE facilities should be 
supported and activated on the device. 

[5] Operations will be performed after selecting 
the options from mobile phone 

[6] The user on the Smartphone should provide 
inputs for the application. 

 
Applications 

[1] Should be built supporting to the android 
version of the Smartphone. 

[2] Should respond to the request of the mobile 
user. 

[3] Giving the permission to access the 
application for mobile phone 

[4] The longitude and latitude will be calculated 
to find the location of the place. 

[5] The use of the maps will be taken for further 
use. 

 
Principles/Actors 

• Users 
                    Mobile user can operate the application 
globally. The users will have full fledged permissions 
for viewing the place. The place can be added with 
the image tag or an audio tag . Hence the application 
does have very important role of the user. 
 
Specific Requirements 
1 Functional Requirements 
              Functional requirements may be 
calculations, technical details, data manipulation and 
processing and other specific functionality that define 
what a system is supposed to accomplish                    
              The functional requirement is to provide a 
robust and manageable system. The application 
should be able to store the data and view locations 
and sharing it in future. 
1.1 The following requirements which are 
vigorously used by user through the application 
are:- 
1. Location on Google Map 
2. Connect by SMS 
3. Connect by E-mail 
4. Connect by Direct Call 
5. Database (SQLite) 

1. Locations on Google Map(Google API) 
             By using this module user can find the 
Paramount Real Estate office location of the 
particular area which are already registered to 
Paramount Real Estate. 

2. Connect by E-mail 
           By using this module user can directly interact 
to Paramount and if user have some query so user can 
send email to Paramount email address and after that 
Paramount Real Estate contact to user. 
 

3. Connect by SMS 
           By using this module user can directly interact 
to Paramount R eal Estate office and if user have 
some query so user can send SMS to Paramount Real 
Estate office and after that Paramount Real Estate 
admin will contact to user as soon as possible. 

4. Connect by  Direct Call(Tool Free) 
           By using this module user can directly call to 
Paramount Real Estate office and if user have some 
query so user can take help by Paramount Real Estate 
about real estate. 

5. Database(SQLite) 
          By using this module interested user can 
register account for purchasing the property or 
apartment/house in Paramount Real Estate.   
 
Non Functional Requirements 
1 Hardware Requirements: 
PROCESSOR : Dual Core 1.2  
GHz Cortex-A9 
RAM  : 512MB 
HARD DISK : 80GB   
  
OPERATING SYSTEM : WindowsXP,   
     Windows   
                   Vista,Windows 7,  
                   Mac X Lion,                                
      Ubuntu Linux 
TECHNOLOGIES     : JAVA 1.6,   
                 J2ME(CLDC 1.1,MIDP  
     2.0) 
  
Eclipse 3.6 (Helios)  
or greater  TOOLS    : Sun Java   
                     Wireless Toolkit 2.5.2 
        
2 Mobile Requirements: 
CONNECTIVITY : EDGE, 3G, GPS 
PHONE MEMORY : Minimum 10MB  
TECHNOLOGY :     JAVA (MIDP 2.0)       

supported mobiles,       
Bluetooth, Camera,        
and Audio Recorder 

 
 
Android: The Android platform is the product of 
the Open Handset Alliance, a group of organizations 
collaborating to build a better mobile phone. The 
group, led by Google, includes mobile operators, 
device handset manufacturers, component 
manufacturers, software solution and platform 
providers, and marketing companies. From a 
software development standpoint, Android sits smack 
in the middle of the open source world.  
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 The first Android-capable handset on the 
market was the G1 device manufactured by HTC and 
provisioned on T-Mobile. The device became 
available after almost a year of speculation, where the 
only software development tools available were some 
incrementally improving SDK releases. As the G1 
release date neared, the Android team released SDK 
V1.0 and applications began surfacing for the new 
platform.  
 To spur innovation, Google sponsored two 
rounds of "Android Developer Challenges," where 
millions of dollars were given to top contest 
submissions. A few months after the G1, the Android 
Market was released, allowing users to browse and 
download applications directly to their phones. Over 
about 18 months, a new mobile platform entered the 
public arena. 

1 The Android platform: 
 With Android's breadth of capabilities, it 
would be easy to confuse it with a desktop operating 
system. Android is a layered environment built upon 
a foundation of the Linux kernel, and it includes rich 
functions. The UI subsystem includes: 

• Windows 
• Views 
• Widgets for displaying common 

elements such as edit boxes, lists, and 
drop-down lists 

Android includes an embeddable browser built upon 
Weskit, the same open source browser engine 
powering the phone’s Mobile Safari browser.
 Android boasts a healthy array of 
connectivity options, including Wife, Bluetooth, and 
wireless data over a cellular connection (for example, 
GPRS, EDGE, and 3G). A popular technique
Android applications is to link to Google Maps to 
display an address directly within an application. 
Support for location-based services (such as GPS) 
and accelerometers is also available in the Android 
software stack, though not all Android devices ar
equipped with the required hardware. There is also 
camera support. 
 Historically, two areas where mobile 
applications have struggled to keep pace with their 
desktop counterparts are graphics/media, and data 
storage methods. Android addresses the graphics
challenge with built-in support for 2
graphics, including the OpenGL library. The data
storage burden is eased because the Android platform 
includes the popular open source SQL light database. 
Below figure shows a simplified view of the Android 
software layers. 
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based services (such as GPS) 
and accelerometers is also available in the Android 
software stack, though not all Android devices are 
equipped with the required hardware. There is also 

Historically, two areas where mobile 
applications have struggled to keep pace with their 
desktop counterparts are graphics/media, and data 
storage methods. Android addresses the graphics 

in support for 2-D and 3-D 
graphics, including the OpenGL library. The data-
storage burden is eased because the Android platform 
includes the popular open source SQL light database. 
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Fig 1: Android software layers
        2  Application Architecture:
 As mentioned, Android runs a
kernel. Android applications are written in the Java 
programming language, and they run within a virtual 
machine (VM). It's important to note that the VM is 
not a JVM as you might expect, but is the Dalvik 
Virtual Machine, an open source technology. Each 
Android application runs within an instance of the 
Dalvik VM, which in turn resides within a Linux
kernel managed process, as shown below.
 

Fig 2: Dalvik VM
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Activity Life Cycle 

Figure 3 : Activity Life Cycle
 

Developing Application 
1. Download the java jdk from below URL and 

follow the below important steps
http://www.oracle.com/technetwork/java/jav
ase/downloads/index.html.  Select the Java 
button, you don't need the Java EE.

2. Install the Java JDK. 
3. Download the SDK (not the 

but the zip file) from the above link. 
Currently you want the android
windows.zip file. 
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Download the java jdk from below URL and 
follow the below important steps 
http://www.oracle.com/technetwork/java/jav

Select the Java 
button, you don't need the Java EE. 

Download the SDK (not the installer exe, 
but the zip file) from the above link. 
Currently you want the android-sdk_r08-

4. Unpack the zip file to the location you want 
to have the SDK installed (doesn't much 
matter where, just remember where you put 
it).  For example  C:\Users
used here. 

5. Add the ANDROID_SWT user variables:
• Open start menu, enter sysdm.cpl into the 

text field and press enter.
• In the opened window, select Advanced 

System Settings on the left.
• Select Environment vari

right corner. 
• Press the New button under the User 

variables windows (the top one).
• Enter ANDROID_SWT in the variable 

name field and the path to the swt    64
SWT file into the variable value field. For 
example 
C:\Users\<YOURUSERNAMEHERE>
oid-sdk-windows\tools\lib
5.6. Press OK in all the windows to close 
them. 

6. Download Eclipse from 
http://www.eclipse.org/downloads/, you 
want Eclipse IDE for Java Developers for 
Windows 64 Bit. Unpack the eclipse folder 
to wherever you want to have eclipse 
installed. Go into the folder and drag the 
eclipse.exe file to your desktop or start menu 
while holding the SHIFT key to make a 
shortcut to Eclipse. 

7. Follow the instructions at 
http://developer.android.com/sdk/eclipse
adt.html to install the Eclipse ADT Plugin. 
Here is the list from that page:

• In Eclipse go to Help > Install New 
Software..... 

• Press Add in the top right hand 
corner. 

• Write ADT Plugin in the name 
field and process with SDK 
https://dl-
ssl.google.com/android/eclipse/ in 
the Location URL. If you get any 
errors, try changing from https to 
http. 

• In the Available Software dialog, 
select the checkbox next to 
Developer     Tools, press Next.

• In the next window, you'll see a list 
of the tools to b
Click    Next. 

• Read and accept the license 
agreements, then click Finish.
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SWT file into the variable value field. For 
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Download Eclipse from 
http://www.eclipse.org/downloads/, you 
want Eclipse IDE for Java Developers for 
Windows 64 Bit. Unpack the eclipse folder 

ever you want to have eclipse 
installed. Go into the folder and drag the 
eclipse.exe file to your desktop or start menu 
while holding the SHIFT key to make a 

Follow the instructions at 
http://developer.android.com/sdk/eclipse-

ml to install the Eclipse ADT Plugin. 
Here is the list from that page: 

In Eclipse go to Help > Install New 

Press Add in the top right hand 

rite ADT Plugin in the name 
field and process with SDK 

m/android/eclipse/ in 
the Location URL. If you get any 
errors, try changing from https to 

In the Available Software dialog, 
select the checkbox next to 
Developer     Tools, press Next. 
In the next window, you'll see a list 
of the tools to be downloaded. 

Read and accept the license 
agreements, then click Finish. 
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• When the installation completes, 
restart Eclipse. 

• After restating Eclipse, go to 
Window > Preferences.... 

• Select Android from the list on the 
left. 

• For the SDK Location in the main 
panel, click Browse... and locate 
your downloaded SDK directory. 

• Click Apply, then OK. 
8. Add the SDK components needed to code 

forAndroid (not just the manager which is 
what you downloaded): 

• In Eclipse select Window > 
Android SDK and AVD Manager. 

• Select Available Packages on the 
left. 

• Check the checkbox next to 
Android Repository to install all 
versions of the SDK (so you can 
develop for all versions of Android 
1.5 - 2.3). 

• Click Install Selected. 
• Accept the licenses, press Accept 

All and then Install. 
9. Follow 

http://developer.android.com/guide/developi
ng/device.html to set up device (Nexus 
One):  

• Connect you Nexus One to the PC 
using an USB cable. 

• When/If Windows says it has failed 
to install drivers for a device, tell it 
you have drivers. If windows 
doesn't ask you for drivers go to the 
start  

• Menu and type devmgmt.msc into 
the field and press Enter. You will 
get a list of all your devices, find 
the one with a red mark and right 
click it. Select Update Driver 
Software. 

• Select Browse my computer for 
driver software. 

• Select Browse and select the 
google-usb_driver folder in the 
SDK folder you unpacked in step 3. 

10. Turn on "USB Debugging" on the Nexus 
One. 

• Press MENU, select Applications > 
Development, then enable USB 
debugging. 

11. Try to see if your Nexus One is connected 
by opening command line (go to start menu, 
enter cmd and press enter). navigate to the 

location of your SDK and the platform-tools 
directory. Run adb devices or just run it 
directly by using the full path: 
C:\Users\<YOUR USERNAME 
HERE>\android-sdk-windows\platform-
tools\adb.exe devices. You should see 
something like: List of devices attached-
HT9DSP500000 device 

12. If you already have a project written in 
Eclipse open the document and  check 
AndroidManifest.xml file, open the 
Application tab at the bottom and then select 
true in the Debuggable drop-down box on 
the left. 

• If you do not have a project, follow 
below useful Url finding 
http://developer.android.com/resour
ces/tutorials/hello-world.html to set 
one up. 

13. To run your in Eclipse select Run > Run 
Configurations... 

• Select Android Application on the 
left and press the New icon. 

• Enter whatever you want in the 
Name field and press browse and 
select the project you want to run. 

• In the target tab. Select Manual. 
• Press run. In the dialog select you 

device and press OK. 
 This section provides a whirlwind tour of 
building an Android application. The example 
application is about as simple as you can imagine: a 
modified "Hello Android" application. You'll add a 
minor modification to make the screen background 
color all white so you can use the phone as a 
flashlight. Not very original, but it will be useful as 
an example. Download the full source code. 

To create an application in Eclipse, select 
File > New > Android project, which starts the New 
Android Project wizard. 
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Fig 4:  New Android project wizards 

 

 
Fig 5:  New Android project debugging and  

 testing process 
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Test Cases 
Module Name: User Login: 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 

Test Inputs Actual Output Obtained Output Description 

Valid Login Mobile no & pwd Success Success Test passed. 
Passes the 
control to the 
Other module 

InValid Login Mobile no & pwd Failed Failed Test Passed. 

Displays the alert  
message 

Test Inputs Actual Output Obtained Output Description 

Valid Login Mobile no & pwd Success Success Test passed. Passes the 
control to the Other 
Module  

InValid Login Mobile no & pwd Failed Failed Test Passed. 

Displays the alert  
message 

InValid Mobile no Mobile no Failed Failed Test Passed. 

Displays the alert  
message 

InValid Pwd Pwd Failed Failed Test Passed. 

Displays the alert  
message 
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Output Screens 
 
Create virtual device:   

 
 
Home Screen: 

 
 
 
 
 
 
 
 
 

Description Screen: 

 
 
Welcome Screen: 
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Enter Details Screen: 

 
 
Customer Details Screen: 

 
 
 
 
 
 
 

Features Screen: 

 
 
Caller Screen: 
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Thank you Screen: 

 
 

Conclusion 
 Organizations intending to deploy mobile 
applications must plan their testing strategy across 
manual and automation testing approaches for 
efficient and error-free delivery. In addition to actual 
device-based testing, emulators should be included as 
an integral part of the testing program. Enterprise 
applications require special testing techniques. 
Outsourcing to vendors who are operating an 
independent testing practice may be a viable option 
to manage the expertise, scalability, and quality 
assurance requirements for mobile application 
delivery. 

• Through this system user can buy or sale his 
property’s from any place like home, office, 
coffee shop etc., 

• User may need not to go to the Real Estate 
Office and no need to search for a broker or 
middle person or third party person. 

• User no need to spend money for getting 
information from the real-estate consultant 

• Through this system user can save his time 
and money. 

• User can market his property and he can do 
auctions with other users through web 
services 

• Through Google maps we can view the site 
location and available flats and land 
locations and also registered Paramount 
Real-Estate office branches. 

 
Future Scope 
 It is not possible to develop a system that 
makes all the requirements of the user. User 
requirements keep changing as the system is being 
used. Some of the future enhancements that can be 
done to this system are: As the technology emerges, 
it is possible to upgrade the system and can be 
adaptable to desired environment. Because it is based 
on object-oriented design, any further changes can be 
easily adaptable. Based on the future security issues, 
security can be improved using emerging 
technologies. 

• This application can run in above 4.0.5 
versions 

• It can run in Portable as well as Landscape 
mode 

• Based on the future security issues, security 
can be improved using emerging 
technologies. 

• Based on the user requirement, we can add 
or upgrade the system to meet user 
requirement 

• If any new technology will come then this 
system can easily adaptable to that 
environment 

• Auctions option can be append to this 
application by maintaining separate database 
and web services 
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